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В соответствии с законом о защите авторских прав, никакая часть этого

руководства не может быть переработана, передана, сохранена в

поисковой системе или переведена на какой-либо язык в любой форме и

любыми способами, электронными или механическими, для любых целей,

без письменного разрешения Envision Product Design.

GW-4 является торговой маркой Envision Product Design.

Информация в этом руководстве может быть изменена без каких-либо

уведомлений.

ПРЕДУПРЕЖДЕНИЕ

Система GW-4 используется в сочетании с радиоактивными элементами, которые
могут нанести серьёзный вред, и должна использоваться только квалифицированным
персоналом, ознакомившимся с разделом «Предостережения» руководства.

Envision Product Design не может быть ответственна за повреждения, вызванные
неправильной подготовкой, использованием или несоблюдением мер безопасности при
использовании системы GW-4.

Намеренное воздействие оборудованием на людей  или  его использование в
медицинских целях является незаконным.

Предупреждение
Что бы удостовериться, что изделие корректно функционирует и используется

надлежащим образом, не используйте его до тех пор, пока полностью не изучите и
добьётесь понимания данного пользовательского руководства. Здесь описываются
процедуры установки, запуска, эксплуатации и устранения неполадок продукта.

Система GW-4 используется с, приобретаемым клиентом, источником рентгеновского
излучения, который производит опасное излучение.

Намеренно подвергать людей воздействию оборудования или  его использование в
медицинских целях является незаконным.

Система GW-4 является предметом особого контроля и должна быть зарегистрирована.
Обратитесь в государственный или местный отдел здравоохранения, прежде чем приступать к
эксплуатации оборудования.

Оператор GW-4 должен быть проинструктирован в вопросах радиационной
безопасности, прежде чем приступать к эксплуатации агрегата.

Неуполномоченный персонал не должен иметь доступ к системе GW-4.
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Продумайте и тщательно следуйте мерам безопасности при эксплуатации системы GW-4.
Меры предосторожности должны гарантировать, что никто не будет подвергаться

излучению, превышающему допустимые нормы.
Меры предосторожности должны гарантировать следование государственным нормам

при эксплуатации GW-4.
Весь персонал и пользователи системы должны иметь личные устройства

радиационного контроля, такие как ТЛД (термолюминесцентный дозиметр), плёночный
химический дозиметр, и/или  карманный дозиметр соответствующий федеральным,
региональным или местным стандартам.

GW-4 не проходил исследование на взрывоустойчивость и не должен использоваться во
взрывоопасной среде.

Эксплуатация должна проводиться таким образом, что бы обеспечить для оператора
наиболее низкий возможный уровень радиации (ALARA).
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Система GW-4
1.0 Краткий обзор
НЕ ПРИСТУПАЙТЕ К ЭКСПЛУОТАЦИИ ОБОРУДОВАНИЯ ДО ПРОЧТЕНИЯ, ПОНИМАНИЯ

И СОГЛАСИЯ С УСЛОВИЯМИ ДАННОЙ ИНСТРУКЦИИ.

Система GW-4 является дистанционно управляемой системой разработанной для
контроля кольцевых стыков трубопроводов. Система включает в себя одну или две
тележки на магнитных колёсах, которые могут быть использованы для проверки труб
диаметром 12’’ и более (для труб диаметром 24’’ и более используется две тележки).
Составной  кабель соединяет тележки с удалённым компьютером.  Оператор за
компьютером может управлять движениями тележки, активировать детектор  и
получать изображения.

Для работы системы, на компьютере должны быть запущены две программы.  Первая,
iX-Pect, служит для получения изображений, вторая – для управления GW-4. Тележки, также,
могут управляться с помощью контроллера вперёд/назад, находящегося непосредственно на
самой тележке.

1.1 Определения
(а) Радиоскопическая Система с рабочей станцией и крепящимися устройствами

(Радиоскопическая Система) обозначает механические компоненты и устройства системы GW-
4 и связанные с ней компоненты.

(б) Компоновка схем (Схема) обозначает карты управления, карты интерфейса,
электронные компоненты, сенсоры и системы соединительных проводов Радиоскопической
Системы.

(в) Программное Обеспечение (Программное Обеспечение) включает в себя все
программное обеспечение, поставляемое и связанное с Радиоскопической Системой, в том
числе встроенный код, программное обеспечение компьютера и исполняемые файлы.

1.2 Право собственности
  (а) Продавец, по условиям договора, продаёт Покупателю Радиоскопическую Систему,

описываемую ранее. После полной оплаты стоимости покупки, право собственности на
Радиоскопической Системы передаётся Покупателю.

 (б) Продавец гарантирует Покупателю персональную, не эксклюзивную лицензию на
право пользования Схемой, воплощённой в Радиоскопической Системе, во всех операциях
связанных с ее эксплуатацией. Покупатель не имеет права копировать, заниматься обратным
инжинирингом, воссоздавать, распространять или раскрывать данную Схему.

(в) Продавец гарантирует Покупателю персональную, не эксклюзивную лицензию для
пользования Программным Обеспечением, используемым в Радиоскопической Системе, для
целей, связанных с эксплуатацией  Радиоскопической Системы. Покупатель не имеет права
копировать, декомпилировать, заниматься обратным инжинирингом или другими способами
воссоздавать, распространять или раскрывать данное Программное Обеспечение.
Программное обеспечение может быть установлено не более чем на 3 рабочих станциях.
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1.3 Ограниченная гарантия
(а) Покупатель полностью ответственен за выбор, использование, эффективность и

пригодность Радиоскопической Системы.
(б) Продавец гарантирует, что при правильном использовании и обслуживании,

механические или электронные детали Радиоскопической Системы и Схемы не будут
подвержены поломкам из-за дефектов материала или качества изготовления сроком на 1 год
после доставки Радиоскопической Системы Покупателю. Пункт 1.3(б) не распространяется на
Программное Обеспечение.

(в) Если Радиоскопическая Система не соответствует гарантийным требованиям из
Пункта 1.3(б), и Покупатель предоставил Продавцу письменное уведомление (в том числе по
факсу) до истечения гарантийного периода, Продавец может исправить дефекты или, по
своему усмотрению, изъять Радиоскопическую Систему, возместив стоимость покупки
Покупателю, после чего Продавец не будет иметь дальнейших обязательств перед
Покупателем.

(г) Если Программное Обеспечение выходит из строя из-за дефекта в самом
Программном Обеспечении, в пределах 1 года после доставки Радиоскопической Системы
Покупателю, и Продавец получает письменное уведомление (в том числе по факсу), Продавец
может заменить данную версию Программного Обеспечения или, по своему усмотрению,
изъять Радиоскопическую Систему, возместив при этом стоимость покупки Покупателю, после
чего Продавец не будет иметь дальнейших обязательств перед Покупателем.

(д) За исключением пунктов, описываемых в параграфе 1.3, Система поставляется по
принципу «как есть», и никакие другие гарантии, явные или подразумеваемые, на неё не
распространяются, включая, но, не ограничиваясь, гарантии ее пригодности для конкретной
цели.

(е) Никакие гарантии, явные или подразумеваемые, не распространяются на следующие
пункты (пункты даны для примера, не являются окончательным списком):

(1) Усовершенствование Радиоскопической Системы, сделанные кем-либо кроме

Продавца;

(2) Детали, программное обеспечение или оборудование для Радиоскопической

Системы, не поставляемые Продавцом или без письменного согласования с

Продавцом

(3) Плохая или неправильная эксплуатация Радиоскопической Системы.

1.4 Промышленная безопасность
Предполагается что оператор и команда, использующая Радиоскопическую

Систему, правильно подготовлены и квалифицированы для проведения безопасной работы
при проведение неразрушающего радиографического контроля на промышленных объектах.
Эта инструкция не описывает требования промышленной безопасности или процедуры
неразрушающего контроля.

1.5 Общие меры предосторожности
Хотя Радиоскопическая Система создана быть портативной и прочной,

компьютеризированное  электронное оборудование и хост-машина являются сложными и
хрупкими элементами. Система должна использоваться с осторожностью, что бы
предотвратить механические и электронные повреждения.
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1.6 Статика
Статическое электричество может вызывать остановку системы визуализации во время

работы. Если это произошло, перезагрузите компьютер для восстановления нормальной
работы.

1.7 Ориентация
Ориентировочные часы используются для направления тележек по трубе. Индикатор на

экране показывает точное местоположение.

1.8 Источник питания
Источники питания компьютера, тележки  и монитора совместимы с 110-240 vac и 50 или

60 hz.

2.0 Список комплектующих
Кол-во Описание № п/п

Система GW-4
1 GW-4 Тележка №1 1

1 GW-4 Тележка  №2 – Опционально* 2

Сменный пояс – A 6R55-M108090 (для систем с

направляющим поясом)

Система Контроля

1 Компьютерная система GW-4– Включает

PCI/MUX Набор карт для камеры, 48vdc

источник питания для тележки

3

1 24” TTL Монитор

1 ПО – Операционная система Windows XP

Professional, программа iX-Pect, программа для

управления движением, диски для

восстановления системы и руководства

5

1 Компьютерная клавиатура 6
1 Компьютерная мышь 7
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3 AC шнуры питания 8
Кабели и разъёмы

1 40m Кабель – От компьютера к Тележке 1 9
1 40m Кабель  – Опционально –От компьютера к

Тележке 2

10

3.0 Установка и настройка системы для работы
3.1 Кабели

Сборка компьютера
Рисунок 1. Задняя часть компьютера – соединение кабелей

Предупреждение – Не присоединяйте/отсоединяйте кабели, когда компьютер
включён
Предупреждение – Не присоединяйте/отсоединяйте кабели к самой тележке,
когда питание включено. Питание тележки можно отключить, отсоединив вилку

на задней части компьютера или выключив сам компьютер. Выключение
компьютера также приведёт к отключению питания Тележки.
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Рисунок 2, 3. Характеристики Тележки. Обратите внимание, тележки, обозначенные

как  “1” и ”2” соответствуют Тележкам 1 и 2 в программном обеспечении.

3.2 Установка Тележки на трубу

Тележка может быть установлена на трубы размером от 12’’. (Тележка, показанная

ниже слегка отличается от используемой в этой системе).

Шаги и инструкции:

1.Установите тележку на трубе используя точку опоры, показанную на картинке.

Устанавливайте тележку с осторожностью, магниты ОЧЕНЬ мощные.

Подключение

Кнопки Движения
вперёд/назад

Стопорное устройство для
установки/съема тележки
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2. Все 4 магнитные колеса должны быть на трубе для корректной работы и

правильного перемещения тележки.

3. Что бы убрать тележку, приподнимите переднюю ручку.
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После того как передние колеса освобождены, поднимите переднюю часть тележки и

придайте вращение задним опорным точкам что бы прервать магнитный поток.
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4.0 Управление тележкой

Для работы с тележкой, необходимо одновременно запустить iX-pect и приложения для
контроля GW-4, расположенные на рабочем столе компьютера. Оба приложения должны быть
запущены для корректной работы.

При запуске GW4 Controller необходимо выбрать тележки,  которые вы собираетесь
использовать. Если вы не выберите одну или обе тележки, GW4 Controller выключится.

Когда программа запускается впервые, она инициализирует тележки и получает данные
об их текущем местоположении. С помощью данного окна можно управлять одной или двумя
тележками, получить информацию о положении и краткую информацию о состоянии системы.
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У каждой тележки имеется шкала калибровки (Truck Angle), которая показывает
физическую ориентацию относительно центра тяжести. У каждой тележки, также, имеется

индикатор абсолютного местоположения. В отличие от калибровочной шкалы, индикатор
местоположения не обязательно отображает физические перемещения тележки, он
показывает полное расстояние пройденное колёсами (для примера, если тележка лишается
сцепления, индикатор это не отразит). Легкодоступна краткая информация о состоянии
системы: Включена (Enabled), Мотор включён (Motor ON), Находится в процессе движения
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(Motion In Progress), Сканирование (Scanning). Для более детальной информации о тележке,
нажмите кнопку “Установки” (Setup).

Положение каждой тележки может быть настроено вручную, используя контроллеры
поворотного управления. Когда тележка заняла необходимое положение, нажмите на кнопку
«Установить данное положение как нулевое» (Set Current Position to Zero). Очень важно
сделать это до нажатия кнопок «Перейти в верхнее положение» (Move To Above Position) и
«Перейти к нулевому дюйму» (Move To Zero Inches)! Например, если тележка 1 находится на 3
дюймах и тележка 2 на 20 дюймах, «Перейти в положение» (Move To Position) 10 приведёт к
тому, что тележка 1 передвинется на 7 дюймов вперёд, а тележка 2 на 20 дюймов назад.
«Скорость Перехода» («Move To» Speed) используется для выбора скорости этих
передвижений.  Ее значения от 1 до 10 такие же, как и значения поворотного управления,
находящиеся под ней.

Когда тележка находится в желаемом месте, вы можете начать процесс сканирования в
iX-Pect.

Впервые в переработанной Системе GW-4, тележки могут определять своё точное
местоположение на трубе в градусах, относительно гравитации. Также добавлена возможность
запоминания тележками места, где они были установлены, и возвращаться туда для удаления.

Пример операции:

1. Установите тележку (и) GW4 на трубу.
2. Перед началом движения, нажмите кнопку «Запомнить положения установки»

(“Save Loaded Positions”).
3. Убедитесь что положение тележки №1 в градусах (рядом с кнопкой «Найти

место» (Find Position)) соответствует желаемому, и нажмите на кнопку «Найти
место» (Find Position). (Если вы используете тележку №1)

4. Повторите то же самое для тележки №2. (Если вы используете тележку №2)
5. Как только тележки заняли свои начальные положения, вы можете нажать на

кнопку «Установить данное положение как нулевое». Это необязательно, но
иначе вы не сможете вернуться в начало сканирования, если потребуется, по
завершению операции. Вы всегда сможете вернуться в положение, в которое
тележки были установлены изначально.

6. Просканируйте изображение.
7. Если вы хотите вернуться к положению начала сканирования, нажмите кнопку

«Перейти к нулевому дюйму» (Move to Zero Inches) (для того что бы это
сработало, вы должны были нажать на «Установить данное положение как
нулевое» в пункте 5).

8. Нажмите на кнопку «Перейти к запомненному положению» (Move to Saved
Positions), для того что бы вернуть тележку в положение первоначальной
установки.

Удалите тележку (и) GW4 с трубы.

При запуске программы, откроется окно, содержащее данный пример. Оно

может быть закрыто в любой момент.
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В окне «Настройка и Диагностика» (Setup and Diagnostics) находится полезный

калькулятор, детализированный сканер статуса движения и геометрические настройки.

Коррекция геометрии и скорости
Запись «Диаметр трубы» (Pipe Diameter) используется только для расчета «Окружности

трубы» (Pipe Circumference). Ее использование не обязательно для корректного проведения
операций.

Измерения D1 и D2 используется для компенсации геометрических парамептров
(масштабирование) путём подстройки скорости тележек. Вы можете использовать любые
единицы измерения (дюймы/миллиметры),  поскольку и D1, и D2 измеряются в одних и тех же
единицах.  Если вы ввели значения D1 и D2, а сканирование все ещё происходит не идеально
и вы не хотите изменять значения D1 и D2, можете ввести значения в поле «Коэффициент
коррекции скорости» (Speed Correction Factor). Значение “1” заставит тележку двигаться со
100% скоростью (оставит без изменений). “1.1” заставит тележку двигаться со скоростью 110%,
а значение “0.9” – со скорость 90%.

Калькулятор дистанции сканирования
Это всего лишь калькулятор, и вводимые данные никак не влияют на программные

операции. Он используется для быстрого расчета дистанции сканирования, основываясь на
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перемещении по поверхности трубы. Например, если вы намеревались просканировать 5
дюймов трубы с геометрией 1.1:1, вы бы получили 5.5 дюймов данных. Калькулятор просто
умножает число, которое вы ввели, на геометрический коэффициент увеличения.

Что бы закрыть окно, нажмите «Сохранить» (Save) что бы сохранить изменения,
«Отменить» (Cancel) что бы вернуться без сохранения.
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Установка
Если система поставлялась вместе с персональным компьютером, программное

обеспечение уже установлено и настроено для работы с системой. В таком случае не
нужно настраивать программное обеспечение, и вы можете пропустить следующую часть.

Установка программы
1. Запустите Windows NT, 2000, или XP and войдите в систему как администратор
2. Вставьте диск с программой в CD/DVD привод
3. Запустите программу “Setup PCI” из корневой папки диска, если она не

запустилась автоматически
4. Нажмите “Установить” (Install)
5. Согласитесь с предложенным или измените каталог для установки программы.

По умолчанию это “D:\iX-Pect SEZ”
6. Нажмите “OK” что бы начать установку
7. После успешной установки, программа сообщит “Driver installed successfully.

Restart the computer”
8. Нажмите “OK” и затем “Выход” (Quit)
9. Перезагрузите компьютер
10. Свяжитесь с Envision по номеру 907-563-1141 (grant@cmosxray.com) для

получения инструкций по регистрации.

Запуск iX-Pect SEZ
 Включите компьютер

1. По запросу, нажмите сочетание Ctrl+Alt+Del
2. Нажмите “Enter” дважды, когда потребуется ввести пароль
3. Процессор  загрузит Windows XP Pro
4. Подождите пока Windows XP закончит процедуру запуска
5. На рабочем столе вы увидите рентгеновский значок под названием "iX-Pect SEZ".

Дважды кликните по нему, что бы запустить программу.
6. Нажмите иконку камеры на панели инструментов

Настройка камеры
После успешной установки, программа должна быть настроена для работы с

подключённой камерой (ами). Для этого запустите программу и выберите
«Конфигурация => Система» (Configuration => System) из меню. Это откроет окно

«Подключенные камеры» (Connected cameras) (см. Рисунок 3)
К одному компьютеру может быть подключено до 3 камер. Соответственно,

доступны три всплывающие поля, в которых можно выбрать подключённые камеры. На
рисунке 3 показаны настройки для системы камер оснащённой SEZ T3-320. Размеры камер
указаны в мм, то есть SEZ T3-320 это 12’’ линейный массив. (80 = 3”, 160 = 6”, 480 = 18”, 640
= 24”)

Камера 1 должна быть настроена в “SEZ T3-80”, если используется одна
тележка, и в“SEZ T3-160”, при использовании двух тележек. Камера 2 и Камера 3

должны быть установлены в “no camera”.

mailto:grant@cmosxray.com
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Нажмите “OK” после настройки опций камеры. После этого, программа проведёт
тест производительности для определения наименьшего времени интеграции. Эта тест
займёт около 15 секунд. Windows будет заблокирована на время теста.

Рис. 3
Введение
Эта глава рассматривает базовые элементы программы. На рисунке 4 показано
главное окно программы, в котором открыты два рентгеновских снимка.

Рисунок 4

Camera 1: |SEZT3-320 H

Camera 2: |no carneia J-J

Camera 3:

Ino camera

....ж....
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Главное меню
Главное меню содержит всплывающие  меню, с помощью которых различные функции

программы могут быть вызваны. Что бы вызвать функцию, нажмите на одно из всплывающих
меню в главном меню. Всплывающее меню откроется, и вы сможете выбрать желаемую
функцию с помощью мыши или клавиатуры. Во время выбора функции, ее краткое описание
выводится слева в строке состояния.

Панель инструментов
Иконки на панели инструментов дают быстрый доступ к наиболее важным программным

функциям. Если вы наведёте курсор на иконку, ее функция отобразится слева в строке
состояния. Нажатия на иконку достаточно для вызова функции. На рисунке 5 показана панель
инструментов и функции иконок.

открыть

окно         сохранить                               выбрать уровень                                                                               параметры

скан          снимок    распечатать              увеличения                       повернуть    инвертировать    быстрого сканирования

 открыть    обрезать    помощь                                                               повернуть    информация

  снимок                                                                                                                          о пикселях

Рентгеновские снимки
Рентгеновские снимки отображаются в центре главного окна. Имя изображения

показано в строке заголовка.
Имеется возможность отображать несколько окон с разными снимками в одно и то же

время. Но всегда только одно изображение может быть выбрано. Заголовок выбранного
изображения окрашен в синий цвет, заголовки всех остальных изображений -  серого цвета.

Часто рентгеновские снимки слишком велики, что бы отобразить их на экране в
реальном масштабе. Поэтому у вас есть возможность выбрать различные коэффициенты
масштабирования. Коэффициент масштабирования может быть изменён нажатием
соответствующей иконки на панели инструментов.

Если курсор мыши находится на изображении, вы также можете выбрать следующий
более высокий уровень масштабирования, кликнув два раза левой кнопкой мыши, или выбрать
менее высокий, кликнув правой кнопкой.

Если, при выбранном коэффициенте масштабирования, рентгеновское изображение не
помещается целиком на экране, выбранная область снимка может быть изменена с помощью
ползунков с правой стороны и внизу.

После сканирования или загрузки изображения, коэффициент масштабирования
автоматически принимает значение «По размерам экрана» (Fit to window) (Символ !^j ) и
изображение масштабируется в соответствие с размером окна.

3.4 Строка состояния
· Строка состояния находится в нижней части главного окна и разделяется на 4 части

(слева направо)

             Начать
Быстрое
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· Общая информация о программе отображается с левой стороны. Если, например, курсор
мыши направить на иконку из панели инструментов, то функция иконки будет показана
именно здесь.

· Координаты и расстояния движения мыши по изображению. Второе поле показывает
координаты, на которые наведена мышь в пикселях, равно как и  уровни оттенков серого.
Во время измерения расстояний, их значения показываются в этом поле. Вы можете
найти более подробную информацию об измерении расстояний в главе 0.

· Индикатор «Повышение контраста» (Contrast enhancement) в этом поле показывает текст
«Повышение контраста», если линейное изменение уровня серого активируется вместе с
«Повышение контраста».

· Индикатор «Линейное изменение» (Linear variation) в этом поле показывает текст
«Линейное изменение», если линейное изменение уровня серого активировано.

· Индикатор «Сплайн (кривая) изменение» в этом поле показывает текст «Сплайн (кривая)
изменение», если  изменение кривой уровня серого активировано.

Сканирование изображений
Если вы выберете функцию «Отсканировать изображение» (Scan image) из главного

меню (или, нажав ®|- иконку в панели инструментов), откроется окно «Отсканировать
изображение» (см. Рисунок 6). В этом окне можно настроить все параметры рентгеновских
изображений. Вы также можете настроить функцию авто сохранения при помощи меню «Файл»
(File) в данном окне и управлять параметрами функции быстрого сканирования (QuickScan).

Диаграмма камеры
Текущая экспозиция камеры отображается в виде диаграммы по центру окна:

· Отдельные пиксели камеры показаны на оси X диаграммы. Первый пиксель камеры
расположен с краю слева; последний пиксель – у правого края диаграммы. (Примечание:
Обычно кабель камеры расположен на краю камеры).

Авто-сохранение
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· Ось Y представляет уровни серого отдельных пикселей. Чем более обнажён пиксель,
тем выше он находится на диаграмме.

· Если параметры сканирования «продолжительность воздействия» или «биннинг» (см.
главу 4.2) изменяются, вы можете наблюдать эффекты от этих изменений прямо на
диаграмме.

·
Параметры сканирования

Параметры сканирования определяют поведения камеры во время процесса
сканирования изображения.

Время интеграции
В линейной камере изображение формируется путём сканирования объекта строка за

строкой. Время интеграции определяет выдержку для каждой строки. Данную выдержку можно
сравнить с выдержкой обычных камер. Длительная выдержка ведёт к более ярким
изображениям.  Если камера подвергается рентгеновскому излучению высокой интенсивности,
можно установить короткое время выдержки. Но если доступна лишь минимальная
интенсивность рентгеновского излучения, время выдержки, соответственно, должно быть
большим.

Минимальная выдержка зависит от камеры, в то время как производительность
компьютера имеет незначительное влияние на неё. Минимальная выдержка возрастает на 0.5
мс, когда задействуется прокрутка. У стандартных камер минимальная выдержка равняется 2
мс. Максимальная выдержка, в основном, равна 4000 мс. Если вы введёте неправильное
значение выдержки, программа откорректирует его автоматически.

Биннинг

Камеры семейства SEZ T3 имеют разрешение в 12 пикселей/мм (размер пикселя – 83
мкм). Некоторые приложения требуют съёмки в высоком разрешении, в то время как другие
требуют низкого разрешения, но высокой скорости съёмки.

PCI интерфейс предоставляет возможность аппаратного биннига пикселей для
увеличения скорости сканирования в высокоскоростных приложениях. Вместо отправки
каждого отдельного пикселя, PCI интерфейс  соединяет два или более примыкающих пикселей
и передаёт их сумму.

Пример 1: время интеграции = 10 мс/линия, Биннинг = 1

=>       Объект сканируется с 12 писклями/мм (размер пискеля 83 мкм)

=>        Скорость сканирования = 0.5 м/мин

Пример 2: время интеграции = 10 мс/линия, Биннинг

= 6

=>       Объект сканируется с 2 пикселями/мм (размер пикселя 0.5 мм)

=>       Скорость сканирования = 3 м/мин

Для биннинга допустимы значения от 1 до 16.

Двойной уровень серого
Квантовый шум рентгеновского излучения является важным фактором, влияющим на

качество рентгеновских снимков. Рентгеновские фотоны не попадают в линейную камеру
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непрерывным потоком, вместо этого они статистически распространены во времени и
пространстве. В результате, квантовый шум накладывается на информацию с изображения,
вследствие чего соотношение сигнала к шуму уменьшается.

Если вы активируете опцию «Двойной уровень серого» (Double Greylevel), квантовый
шум уменьшается наполовину. В таком случае достигается заметно более высокое качество
изображения; однако, время сканирования увеличивается в четыре раза.

Размер изображения
Здесь вы можете ввести длину сканируемой области, которая будет учтена во время

процесса сканирования.

Информация о сканировании
В информационных полях этой области, программа показывает информацию,

относящуюся к процессу сканирования. Необходимая информация варьируется в зависимости
от корректировок параметров сканирования. Во время ввода параметров сканирования,
информационные поля, в которые требуется ввести параметры, отображаются синим цветом.

Скорость объекта в мм/с и м/мин
Что бы сделать снимок, во время сканирования необходимо двигать либо сам

объект, либо камеру и источник рентгеновского излучения. В обоих случаях должна
поддерживаться определённая скорость, для того что бы объект был отсканирован без
помех. Эта скорость зависит от времени интеграции и параметров биннинга, равно как и
от геометрического масштабирования объекта. В дополнение, скорость уменьшается в
четыре раза при включении «Двойной уровень серого» (Double Grey level).

Оба информационных поля «Скорость объекта (мм/с)» (Object speed (mm/s)) и
«Скорость объекта (м/мин)» (Object speed (m/min)) показывают скорость с которой объект
должен двигаться, что бы съемка могла вестись без помех. Показанная скорость
относится только к процессу сканирования без масштабирования. Если объект
масштабируется, скорость должна делиться на коэффициент увеличения.

Скорость объекта (в м/мин) получается из:

1       *p   m       i        x   mg        e6  m s  l   0

v 4 ------- m ------------------ / ------m------------ *i ------------n ----

1   *i        n2   n        [t * mes t ig      1amo      m   gm0na

Масштабирование объекта определяется установкой машины рентгеновского

контроля. Может быть рассчитано следующим образом:

d b      s    e i t    aab c wnn ja

m i   a=o1 н—^i --------n --------o ------o ----- 1 ---- e

Разрешение
Данное поле показывает разрешение, в котором сканируется объект. Разрешение

определяется из биннингового параметра сканирования.
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Время сканирования
Данное поле показывает полное время сканирования. Время сканирования зависит от

времени интеграции и параметров размера изображения. Время сканирования  увеличится в
четыре раза при включённой опции «Двойной уровень серого» (Double greylevel).

Калибровка
Когда камера подвергается однородному воздействию, все пиксели камеры должны

иметь одинаковое значение. Но каждый пиксель имеет индивидуальное смещение и усиление.
Поэтому значения пикселей из линии, подвергаемой однородному воздействию, будут
отличаться друг от друга. Этот физический эффект называется «PRNU = pixel response non
uniformity» (отклик пикселей не единообразен). В результате PRNU, на полученном
рентгеновском снимке будут видны полосы в направлении сканирования.

Что бы избавиться от этих полос, камера должна быть откалибрована. Во время
калибровки, производится ряд измерений, каждое при разной интенсивности рентгеновского
излучения. Это даёт возможность для математической корректировки PRNU. Результат этих
измерений сохраняется в файле, что бы ими можно было воспользоваться позднее.

PRNU зависит от

1. Спектра рентгеновского излучения, а следовательно, от источника излучения,

напряжения, тока и исследуемого объекта.

2. Времени интеграции

3. Биннинга

4. Геометрических установок

Поэтому если вы меняете один или несколько из этих параметров, вы должны выбрать
подходящий калибровочный файл. Если калибровка этих параметров не производилась до
этого, вы должны создать новый калибровочный файл.

Если текущий калибровочный файл не подходит к регулировке параметров
сканирования «время интеграции» и «биннинг», кнопка «Калибровка» (Calibration) моргает
красным цветом. Это свидетельствует о том, что должна быть проведена новая калибровка
или  выбран другой калибровочный файл.

Калибровка камеры

Пожалуйста, осуществите следующие шаги, что бы откалибровать камеру:

1. Уберите все объекты, находящиеся между камерой и источником рентгеновского

излучения.

2. Откройте окно «Сканировать изображение» (Scan image) (выберите Файл (File)

=> Сканировать изображение (Scan image) из меню)

3. Калибровка должна быть выполнена с теми же параметрами, с которыми

в дальнейшем будет производиться сканирование. Поэтому выставьте

значения параметров «биннинг» и «время интеграции» равными тем,

которые вы будете использовать для облучения объекта (см. Глава 0)

4. Что бы открыть окно калибровки камеры (см. Рисунок 7), нажмите на
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кнопку «Калибровка» (Calibration):

Рисунок 7

Как уже было упомянуто, при калибровке производится несколько измерений при разной
интенсивности рентгеновского излучения. Вы можете ввести количество измерений в поле
рядом с кнопкой «Начать новую калибровку» (Start new calibration). 3 измерения являются
стандартным значением. Допустимы значения от 3 до 10. Для оптимальных калибровочных
результатов установите значение “10”.

Важно проводить калибровочные измерения в том же диапазон оттенков серого, в
котором будет находиться снимок. Этот диапазон может быть установлен при просмотре
изменения в показе уже отсканированного изображения или, для нового объекта:

Для удобства определения значений уровня серого по снимку нового объекта, а также
определения оптимальной энергии (кВ и мА) и времени интеграции (мс) для проверки,
выполните следующее:

1) Установите объект в центр сегментированного массива (SegmentedArray)

2) Установите значение времени интеграции на начальный уровень (например,

20 мс; больше - для большей интенсивности; меньше - для меньшей

интенсивности) в окне «Сканирование изображения» (Scan Image). Шаги,

приведённые ниже, могут быть опробованы с различными значениями времени

интеграции, что бы определить его влияние на диапазон оттенков серого

(контраст) для интересующих частей объекта.

3) Начните калибровочный процесс, нажав «Калибровка» (Calibration) в окне

«Сканирование изображения», затем, нажмите «Начать новую калибровку»

(Start new calibration). Это заставит регистратор перейти к центру панели.

Калибровочное окно может быть сдвинуто за пределы дисплея путём

нажатия и перетаскивания.
Обезопасьте район облучения и начните облучение с интенсивностью (кВ и мА) которое,

по опыту, покажется вам необходимым для данной плотности объекта. Когда излучение
достигнет заданного уровня, графический индикатор на мониторе будет показывать выходные
данные с линейного датчика в реальном времени. Каждый участок датчика, не заслонённый
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объектом, будет показывать очень высокий уровень выходных данных, измеряемых в уровне
серого от 0 до 4096. Хорошее изображение может быть получено, когда большая часть
плотных участков объекта имеют значение от 300 до 1000. Наименее плотные участки,
интересующие нас, должны иметь значения менее 3500. На снимке ниже, показан объект со
значениями уровня серого от 300 до 2200. На концах линии показаны насыщенные пиксели при
отсутствии объекта в сегментированном массиве (SegmentedArray).

4) Увеличивая время интеграции (мс) и/или силу тока (мА) источника, можно

повысить значения уровня серого. Также, минимальное необходимое

значение кВ для проникновения в наиболее плотные из интересующих нас

участков можно вычислить, наблюдая на графике как изменяются

значения кВ в настройках источника.

5) Пометьте, какой диапазон значений уровня серого в интересующих

участках обследуемого объекта. В приведённом примере, диапазон от

300 до 2200. Это диапазон где шаги калибровки предпринимаются так,

что бы измерение «Насыщенности» держалось на уровне 2200 или чуть

выше, а последующие шаги должны быть уменьшены примерно до 300.

Сейчас, когда вы определили допустимое время интеграции и диапазон мощности,
уберите объект из сегментированного массива и начинайте процесс калибровки.

Программа будет руководить вами шаг за шагом во время всех измерений необходимых
для калибровки. Для этих целей откроется новое окно. Количество текущих измерений и
описание отображаются в левой части окна.

После нажатия на «Начать измерения» (Start measurement), начнутся измерения. Во
время измерения, рентгеновский ток и напряжение изменить нельзя.
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В любой момент вы можете остановить калибровку, нажав кнопку «Отмена» (Cancel).
Одиночные измерения для калибровки происходят в следующем порядке:

1. Измерение смещения

Первое измерение делается без рентгеновского воздействия.

Поэтому сперва выключите рентгеновскую трубку, а затем

начинайте измерения.

2. Измерение насыщенности
Второе измерение будет производиться с использование максимальной интенсивности

рентгеновского излучения. Для второго измерения необходимо включить рентгеновскую трубку
скорректировать значения рентгеновского тока и напряжения, при которых в дальнейшем и
будет облучаться объект.

ВАЖНО
Пожалуйста, обратите внимание, что бы ни передержать сегментированный

массив или отдельные пиксели сегментированного массива во время второго
измерения. Что бы проверить, не передержан ли сегментированный массив,
посмотрите на диаграмму камеры в фоновом окне. Передержанные пиксели
находятся рядом с верхним краем диаграммы, и у них отсутствует дизеринг.
Дизеринг является эффектом квантового шума рентгеновского излучения. Когда
пиксель перенасыщен, дизеринг прекращается, это начинает происходить,
примерно, в 85% диапазона.

Перенасыщение сегментированного массива, во время второго измерения,
фальсифицирует калибровку. Поэтому, если вы заметили перенасыщение, убавьте
частоту рентгена или начните новую калибровку с меньшим временем интеграции.

Для случаев с более высокими мощностями (например, >150кВ/2мА),
аттенюатор, плотностью, приблизительно, от  1/2 до 3/4  от плотности
обследуемого объекта, будет использоваться для уменьшения мощности во время
калибровки. Материал однородной плотности, такой же, как и объект исследования,
может быть помещён на отверстие рентгеновской трубки во время всех
калибровочных шагов, что бы второй калибровочный шаг не насыщал
сегментированный массив. В таком случае, калибровочные шаги должны быть
предприняты в том же диапазоне оттенков серого, что и с интересующим
объектом, как описывалось выше.

Когда вы установили силу тока и мощность в рентгене, можете начинать
измерения.

3. Измерения 3, 4 и 5

Интенсивность рентгеновского излучения постоянно уменьшается для всех измерений,
следующих за вторым.  Начиная с третьего измерения, ползунок отображается с правой
стороны окна калибровки. Ползунок показывает вам правильно ли настроена мощность
излучения для следующего измерения. Если ползунок указывает на «излучение ОК» (radiation
OK), можно начинать измерения. Если ползунок указывает на «слишком много рентгеновского
излучения» (too much x-ray-radiation) или «слишком мало рентгеновского излучения» (too little x-
ray radiation), интенсивность излучения должна быть либо уменьшена, либо увеличена.
Наиболее простой способ скорректировать интенсивность - с помощью силы тока в
рентгеновской трубке. Напряжение рентгеновской трубки, если возможно, лучше оставить без
изменения. В некоторых рентгеновских генераторах невозможно вручную изменить силу тока.
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В таких случаях, интенсивность рентгена должна быть скорректирована при помощи мощности
рентгеновской трубки.

После того как все измерения успешно проведены, вы должны ввести имя файла в
котором будут храниться данные калибровки. Имя файла должно содержать параметры
калибровки. Например, используя калибровку для рентгеновского излучения в 100 кВ / 6 мА с
установками: время интеграции = 5мс, биннинг = 1, вы называете файл  «100kV 6mA 5ms PB1».

После того как вы ввели имя файла и нажали «ОК», перед вами снова появится окно
калибровки. Теперь, только что полученный файл калибровки, показывается в верхней части
экрана вместе с параметрами снимка «время интеграции» и «биннинг». Нажмите «ОК» что бы
вернуться в окно сканирования.

Выбор файла калибровки
Если вы меняете параметры рентгеновского излучения или параметры изображения на

те, для которых вы уже провели калибровку, вам не нужно заново проводить калибровку. Вы
просто должны выбрать подходящий файл калибровки. Для этого, откройте окно калибровки,
нажав «Калибровка» в окне сканирования. В окне калибровки вы можете нажать «Выбрать
файл» (Choose file) и выбрать нужный калибровочный файл.

Пример:

1. При 80 кВ/ 10 мА вы провели калибровку со временем интеграции в 10мс и

биннингом 1. Вы сохранили результат под именем «80kV 10mA 10ms PB1»

2. Затем вы расширили биннинг до 6 и сделали новую калибровку. Результат

был сохранен под именем «80kV 10mA 10ms PB6»

3. Теперь вы снова хотите сделать снимки с биннингом 1. Как только вы изменили

параметр биннинга с 6 на 1, кнопка «Калибровка» начала мигать красным. Тем

самым показывается, что файл калибровки не подходит к параметрам

визуализации. Теперь нажмите на «Калибровка» что бы открыть калибровочное

окно. В калибровочном окне, поле «Биннинг» мигает, что бы показать, что

биннинг калибровочного файла не соответствует скорректированному биннингу.

Нажмите «Выбрать файл» и выберете файл «80kV 10mA 10ms PB1»

4. После этого вы можете закрыть калибровочное окно снова. Теперь кнопка

«Калибровка» больше не моргает так как параметры времени интеграции и

биннинга соответствуют значениям из калибровочного файла.

Линия-эталон
В некоторых случаях может быть полезным сравнить выдержку линии в различных

условиях. С ее помощью можно сравнить, например, контраст объекта при различных
рентгеновских излучениях. В дополнение вы можете использовать эту функцию во время
корректировки камеры, что бы проверить правильно ли настроена камера по отношению к
рентгеновской трубке.

Если вы нажмёте на «Сохранить как эталон» (Save as Reference) в окне сканирования,
текущая линия, которая показана на диаграмме, будет сохранена как эталон. Вы можете
скрыть или показать ее, нажав на кнопку «Показать эталон» (Show reference). Линия-эталон
отображается синим цветом. Линия-эталон не сохраняется после выхода из программы,
поэтому если вы закроете программу, линия-эталон будет потеряна.
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Конфигурация прокрутки
В этой части окна сканирования вы выбираете, будут ли данные об изображении

показываться интерактивно во время сканирования в полноэкранной прокрутке. Более
детальную информацию о прокрутке вы можете найти в Главе 4.6

Работа с набором параметров быстрого санирования
Рентгеновские параметры в окне сканирования могут храниться в виде  набора

параметров быстрого сканирования (QuickScan Parameter Sets) и быть загружены позже снова.
Вы можете назначить различные параметры изображения для разных объектов и быстро
вернуться к ним в будущем, не прибегая к ручной настройке. В дополнение, вы можете
выбрать параметры быстрого сканирования (Quickscan-Parametersets) прямо из панели
инструментов в главном окне и начать процесс сканирования, не открывая окно сканирования.

Следующая информация будет храниться в параметрах быстрого сканирования:

1. Размер изображения

2. Время интеграции

3. Биннинг

4. Установка «двойного уровня серого»

5. Настройки прокрутки

6. Выбранный PRNU-файл

Сохранение параметров быстрого сканирования
Для того что бы сохранить текущие настройки

окна сканирования, выберите «Файл => Сохранить
параметр сканирования» (File =>Save scan parameter)
из меню окна сканирования. Тем самым вы откроете
окно «Сохранить набор параметров» (см Рисунок 8).
Теперь вы можете ввести имя набора параметров в
верхнем поле окна. Уже сохранённые наборы
параметров отображаются в списке «Существующие
параметры» (Existing Parametersets).

Если вы нажмёте на имя в списке
существующих параметров, вы можете
переименовать или удалить выбранный набор
параметров с помощью кнопок «Переименовать»
(Rename) или «Удалить» (Delete).

Нажмите «ОК» что бы сохранить текущие настройки, введя имя в поле «Имя набора
параметров» (Name of Parameterset). С помощью «Отмена» (Cancel) вы можете прервать
сохранение параметров.

Загрузка набора параметров быстрого сканирования
Для того что бы загрузить настройки окна сканирования из набора параметров быстрого

сканирования, выберите «Файл => загрузить параметр сканирования» (File => Load scan
parameter) из меню окна сканирования. Тем самым, вы откроете окно «Загрузить набор
параметров» (Load parameterset) (см. Рисунок 9). Список сохранённых наборов параметров
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показывается здесь.  Если вы нажмёте на имя из списка,  оно выделится синим цветом.  С
помощью кнопок «Переименовать» (Rename) или «Удалить» (Delete) вы можете
переименовать или удалить выбранный набор параметров. Но если, вместо этого, вы нажмёте
«ОК», настройки этого набора параметров будут загружены и утверждены в окне сканирования.
При помощи кнопки «Отмена», вы можете прервать загрузку набора параметров.

Начало процесса сканирования из

панели инструментов в главном окне
При помощи всплывающих полей на

панели инструментов главного окна, вы
можете выбрать сохранённый набор
параметров быстрого сканирования. Если
вы нажмёте на иконку быстрого сканирования Q$|, процесс сканирования будет автоматически
запущен с настройками из выбранных наборов параметров.

Функция авто-сохранения
После процесса сканирования вы можете сохранить новое изображение, нажав «Файл

=> Сохранить» (File => Save) или «Файл => Сохранить как» (File=>Save as). Вы также можете
автоматизировать процесс сохранения изображения при помощи функции авто-сохранения.

При включённой функции авто-сохранения, имя файла автоматически генерируется
после каждого сканирования, и новое изображение храниться под этим именем. В окне «Авто-
сохранение» (AutoSave) вы можете включить и выключить функцию авто-сохранения. Здесь вы
также можете задать, как будет генерироваться имя файла.

Для того что бы открыть окно «Авто-сохранение», выберите «Файл => Загрузить
параметр сканирования» (File => Load scan parameter)из меню окна сканирования.

Для того что бы включить функцию авто-сохранения, поставьте галочку рядом с
«Включить авто-сохранение» (Enable AutoSave). После этого вы можете назначить, как будет
генерироваться имя файла.
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Режим авто сохранения  («Behavior»)

Здесь вы можете определить общий режим  функции авто-сохранения после процесса
сканирования:

1. «Сохранить изображение» (Save image)

Если данная опция активирована, изображение будет сохраняться и

оставаться открытым.

2. «Сохранить и закрыть изображение» (Save and close image)

Если данная опция активирована, изображение будет сохраняться и сразу

же после этого закрываться.

Если, в дополнение, включена опция «Перезаписать существующие файлы без
напоминания» (Overwrite existing files without prompt), программа перезапишет существующие
изображения с такими же именами, не принимая мер предосторожности.
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Тип файла (File type)
Здесь вы можете назначить, в каком формате будут сохраняться изображения функцией

авто-сохранение. Формат может быть выбран между PIX, BMP и FLD.

Папка (Folder)
Здесь вы можете назначить в какую папку программа должна сохранять изображения.

Вы можете либо ввести папку в поле напрямую, либо выбрать нужную папку нажав кнопку
«Обзор» (Browse).

Важно: папка, в которую будут сохраняться изображения, должна существовать.

Имя файла (File name)

В этом поле вы можете ввести начало имени файла. Эта часть автоматически
генерируемого имени файла останется неизменной и будет дополнена индексом и,
опционально, датой и временем сохранения.

Индекс (Index)
Это поле указывает индекс следующего изображения. Данное значение добавляется к

имени файла (см. Глава 0). Индекс увеличивается на 1 после каждого сканирования.
С помощью опции «Сбросить индекс» (Reset Index) вы можете указать должен ли индекс

сбрасываться каждый час или день до определённого значения.

Время и дата (Options)
С помощью двух опций «Дата» (Date) и «Время» (Time) вы можете указать должны ли

дата и/или время когда изображение было сохранено включаться в имя файла.

Пример (Example)
Поле «Пример» (Example) отображает как будет выглядеть сгенерированное имя

файла.

Начало сканирования
Для того что бы начать процесс сканирования, нажмите на кнопку «Начать

сканирование» (Start scan) в окне сканирования. Для того что бы закрыть окно сканирования,
не начиняя процесс сканирования, нажмите «Отмена» (Cancel).

Настройки окна сканирования будут сохранены только в том случае, если вы нажмёте
на «Начать сканирование». Но если вы нажмёте на «Отмена», все изменения и настройки окна
сканирования будут утеряны. Тем не менее, профили сканирования и настройки авто-
сохранения останутся, когда вы закроете окно нажав «Отмена».

Прокрутка во время процесса сканирования
Во многих приложения, объекты непрерывно переносятся в систему рентгеновского

контроля. Оператор рассматривает рентгеновские снимки и решает, является ли, только что
отсканированный объект, дефектным. Для таких приложений слишком трудоёмко начинать
новый процесс сканирования для каждого объекта и проверять снимки только после окончания
процесса сканирования.

Поэтому программа предлагает возможность представлять данные изображения в
реальном времени во время процесса сканирования в виде прокрутки изображения. Прокрутка
продолжается до тех пор, пока не останавливается нажатием клавиши.
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Принцип прокрутки
Для того что бы создать прокрутку, программа отображает новые линии изображения,

наряду с предыдущими, на экране. Итак, первая считанная строка отображается на первой
строке экрана, вторая прямо под ней на второй строке экрана, и так далее. Когда программа
достигает самой низкой строки экрана, содержимое сдвигается вверх после каждой считанной
линии и новая линия отображается на нижней строке экрана. Тем самым, достигается
плавность прокрутки изображения.

Общая информация о режимах прокрутки экрана
Для того что бы предоставить рентгеновское изображение в наиболее высоком, из

возможных, разрешений, программа, во время прокрутки, переключает экран в другой режим.
Поэтому, для того что бы ни возникло проблем, программа должна знать какие разрешения и
при каких частотах поддерживает монитор.

Для того что бы установить разрешения, поддерживаемые монитором, выберите
«Конфигурация => Режимы прокрутки экрана» (Configuration => Scrolling Display modes) из
меню в главном окне. Там вы можете открыть окно «Настройка режима прокрутки» (Scrolling
mode configuration) (см. Рисунок 12).

Рисунок 12

В этом окне перечислены все режимы экрана, которые поддерживает программа.
Первая колонка показывает разрешение соответствующего режима экрана. Во второй колонке
вы можете выбрать частоту экрана, которая будет использоваться с этим разрешением, с
помощью всплывающего поля. Изучите инструкцию к своему монитору. Там должна быть
таблица, описывающая какие максимальные частоты для каждого разрешения, которое
поддерживает монитор. Для режимов, которые не поддерживаются вашим монитором,
выберите «режим отключён» (mode disabled), что бы программа не использовала их при
прокрутке.

Нажав на кнопки «Поверить (5 секунд)» и «Проверить (20 секунд)», вы можете
проверить настройки каждого режима экрана. Если вы нажмёте на одну из этих кнопок,
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произойдёт проверка экрана в соответствующем разрешении и выбранной частотой, длиной в
5 или 20 секунд. Вы также можете использовать проверку для корректировки изображения на
мониторе (горизонтальное и вертикальное центрирование и т.д.)

Какой из параметров дисплея программа будет использовать для прокрутки, зависит от
камеры и параметров сканирования. Поэтому, вы должны выставить правильные параметры
для всех перечисленных режимов экрана.

Примечание: чем больше частота во время скроллинга, тем более комфортным будет
длительное нахождение пользователя у монитора.

Параметры прокрутки в окне сканирования
В разделе «Конфигурация прокрутки» (Scrolling configuration) окна сканирования, вы

можете установить прокрутку для следующего сканирования.

Включение или выключение прокрутки
Нажав на кнопку «Использовать прокрутку»  (“Use scrolling” ) вы можете включить или

выключить прокрутку. Если кнопка нажата, процесс сканирования будет осуществлён с
использованием прокрутки.

Прокрутка может быть включена только при условии, что все пиксели линии камеры
отображаются на одной линии экрана. Поэтому, возможно вам сперва придётся увеличить
значение биннинга, что бы включить прокрутку.

Если вы попытаетесь включить прокрутку при слишком низких значениях биннинга,
программа выдаст соответствующее предупреждение. Из этого предупреждения, вы сможете
выяснить, какое минимальное значение биннинга должно быть установлено, что бы включить
возможность прокрутки. Также, вы получите предупреждение, если попытаетесь изменить
значение биннинга на недопустимое, во время включённой прокрутки.

Пример 1:

Используемая камера: SEZ T3-480 (18”)

Максимальное разрешение экрана:   1280 x 1024 пикселей

Режимы экрана 1600x1200 и 2048x1536

выключены

Таким образом, ваш монитор может отобразить строку из, максимум, 1280

пикселей. 18” камера допускает разрешение в 5508 пикселей (биннинг = 1). Для

работы прокрутки, необходимо минимальное значение биннинга = 5.

При значении биннинга 5, камера будет передавать 5508/5 = 1100 пикселей. Эти

пиксели умещаются в одну строку экрана. При значении биннинга 4, камера будет

передавать 5508/4 = 1377 пикселей, и эти пиксели больше не помещаются в одну

строку экрана.

Пример 2:

камера: SEZ T3-480 (18”)

Максимальное разрешение экрана:   2048 x 1536 пикселей
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Таким образом, ваш монитор может отобразить строку из, максимум, 2048

пикселей. Для работы прокрутки, необходимо минимальное значение биннинга =

3.

При значении биннинга 3, камера будет передавать 5508/3 = 1836 пикселей. Эти

пиксели умещаются в одну строку экрана. При значении биннинга 2, камера будет

передавать 5508/2= 2754 пикселей, и эти пиксели больше не помещаются в одну

строку экрана.
Отключить прокрутку при слишком малом облучении

Используя функцию «Остановить прокрутку, если облучение менее…%»  (“Stop scrolling
when less than...% exposure”) вы можете настроить временное отключение прокрутки, если
среднее облучение линии становится меньше определённого процента. С помощью этой
опции, например вы можете автоматически остановить прокрутку, когда рентгеновская трубка
выключается. Прокрутка возобновиться вновь, как только среднее облучение линии вновь
превысит определённый процент.

Для того что бы включить эту функцию,  поставьте галочку рядом с «Остановить
прокрутку, если облучение менее…%» (Stop scrolling when less than ...% exposure). Затем вы
можете ввести пороговое значение облучения, по достижению которого прокрутка будет
отключена.

Изменение уровня серого во время прокрутки
В главе 6 детально описывается, как вы можете выровнять видимый контраст

рентгеновского снимка с помощью изменения уровня серого, так что бы вы смогли видеть
важные детали. Вы также должны использовать эту функцию для прокрутки.

Сперва,  вы должны сделать рентгеновский снимок объекта, который собираетесь
обследовать. Затем настройте изменение уровня серого как описано в главе 6, что бы можно
было видеть важные детали объекта. После этого, вы должны сохранить параметры
изменения уровня серого в файле изменения (см. Глава 6.4)

Теперь снова откройте окно сканирования. В поле «Конфигурация прокрутки» (Scrolling
configuration) найдите «Применить изменение из …» (Apply variation from ...) В это поле вы
можете ввести только что сохранённый файл изменения уровня серого для отображения
рентгеновского снимка во время прокрутки. Для этого нажмите «Выбрать файл» (Choose file) и
выберите соответствующий файл.

Важно: Файл изменения будет использоваться только, если опция «Применить

изменение из…» (Apply variation from ...) помечена крестиком и кнопка

«Калибровка» (“Calibration”) не моргает красным.

Значение поля «Размер изображения» (“Image size” ) для прокрутки

Если прокрутка не включена, поле «Размер изображения» определяет, сколько линий
должно быть считано во время процесса сканирования. Но прокрутка работает в непрерывном
режиме. Это значит, что она продолжается до тех пор, пока пользователь не остановит ее,
нажав пробел.

Тем не менее, поле «Размер изображения» влияет на процесс сканирования при
активной прокрутке: оно определяет, сколько из последних прочитанных линий должно быть
сохранено во время сканирования. Если, например, размер изображения выставлен на 3000 и
пользователь выключает прокрутку нажатием пробела, последние 3000 линий будут
отображаться на снимке.
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Изменение уровня серого
Изменение уровня серого является одной из наиболее важных функций обработки в

программе.
Динамический диапазон камеры системы составляет 12 бит. Это означает, что

рентгеновские снимки делаются с 4096 уровнями серого. Пиксели с низким значением
отображаются на экране темными, а пиксели с высоким значением – яркими.

Человеческий глаз, однако, может различить от 40 до 50 уровней серого, монитор,
также, не может отобразить все 4096 уровней серого.

Кроме того, рентгеновские снимки очень редко используют полный диапазон уровней
серого. Градация серого у объекта не достигает ни значения 0 (чёрный), ни значения 4095
(белый), но, например, находится в диапазон от 1100 (темно-серый) до 2600 (светло-серый).

По этим причинам, часто детали объекта остаются невидимыми для наблюдателя на
рентгеновском снимке, даже если и были запечатлены рентгеновской камерой. При помощи
изменения уровня серого вы сможете изменить представление рентгеновских снимков так, что
бы эти детали объектов стали отчётливо видны.

Гистограмма
Прежде чем вы начнёте работать с градацией серого, вы должны понять значение

гистограммы: Посредствам гистограммы можно увидеть, сколько пикселей на единицу
значения пикселей содержится на снимке. На рисунке 11 показан рентгеновский снимок
цилиндрической алюминиевой части и соответствующая гистограмма.

Горизонтальная ось X на гистограмме представляет детализированные значения
пикселей от 0 (левый) до 4095 (правый). Количество пикселей на рентгеновском снимке,
содержащееся в значении пикселя, отмечено  в виде вертикальной черты над каждым
значением пикселя. Чем больше пикселей на снимке имеют отдельное пиксельное значение,
тем выше соответствующая черта.

Рентгеновский снимок на Рисунке 13 может быть разделён на 3 большие части: Тёмный
объект (1), ярка часть посреди объекта (2) и яркий фон (3).

С левой стороны вы можете видеть
кластер с двумя пиками. Этот кластер
соответствует объекту: Большая часть снимка
тёмная. Поэтому много пикселей имеют низкое
пиксельное значение, создавая тем самым пик
(1). Но объект несколько ярче в середине, что
создаёт пик (2). Переходы от светлой части
объекта к темной являются плавными, создавая
плавные переходы между пиком (1) и (2) на
гистограмме.

Затем вы можете видеть узкий кластер (3)
справа на гистограмме, являющийся ярким
фоном снимка.

Гистограмма также содержит дальнейшую
информацию: Вертикальная ось Y представляет
яркость от тёмного (низ) до светлого (верх). С
помощью белой линии на гистограмме, вы
можете наблюдать, на каком уровне яркости
находятся отдельные значения пикселей, показанные на экране. В примере с Рисунка 13,
белая линия проходит линейно из нижнего левого в верхний правый угол. Это означает, что
пиксели с низким пиксельным значением отображаются темными, а пиксели с высоким
пиксельным значением – светлыми.

Все пиксели объекта находятся в левой части гистограммы. В левой части гистограммы,
белая линия проходит снизу (чёрный) до одной третей от высоты гистограммы (темно-серый).
Поэтому яркость пикселей объекта находится в диапазоне от чёрного до темно-серого. Часть,
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находящаяся в диапазоне яркости от темно-серого до белого, является фоном объекта и не
представляет особого интереса. Для наблюдателя будет выгодно, если объект будет
использовать полный диапазон яркости от тёмного до светлого. Именно такае контрастное
изображение может быть достигнуто с помощью изменения уровня серого.

Использование функции изменения уровня серого
Существуют два различных вида градации уровня серого: «Линейная градация

серого» (“linear greylevel variation”) и «Криволенейная градация серого»( “spline greylevel
variation”). Эта глава объясняет различия между двумя этими видами и работу функции
изменения уровня серого.

Окно изменения уровня серого
Если вы выберите «Изменение уровня серого => Назначить изменение» (Greylevel

variation => Define variation) из меню или нажмёте на иконку Ш в панели инструментов,
откроется окно, в котором вы сможете установить изменение уровня серого. По центру этого
окна, вы можете видеть таблицу свойств. В этой таблице свойств находятся две вкладки:
«Линейное изменение уровня серого» (Linear greylevel variation) и «Криволинейное  изменение
уровня серого» (Spline greylevel variation).  С помощью этих двух вкладок вы сможете
переключаться между двумя типами изменения уровня серого. В зависимости от того какой тип
включён, различные настройки доступны в таблице свойств.

Ниже таблицы свойств находятся 5 дополнительных кнопок:
Вы можете остановить изменение уровня серого в любое время нажав «Отмена»

(“Cancel”). В таком случае, программа использует изменение уровня серого, которое было
установлено до вызова функции. Если вы выберите «ОК», вы подтвердите текущие настройки
изменения уровня серого.

Значения кнопок «Загрузить» (Load), «Сохранить» (Save) и «Новое изображение» (New
image) будут объяснены в Главе 9.

Линейное изменение уровня серого
При линейном изменений уровня серого, вы указываете нижний и верхний пределы в

значениях. Все пиксельные значения ниже предельного значения отображаются в чёрном
цвете, все пиксельные значения выше предельного значения отображаются в белом цвете.
Яркость пиксельных значений находящихся в заданных пределах линейно увеличивается от
чёрного к белому.

На Рисунке 14 показано окно, при котором  вы выбрали вкладку «Линейное изменение
уровня серого» (“Linear greylevel variation”).
Прямо под гистограммой, в вашем распоряжении
находятся три ползунка «тёмный» (dark),
«светлый» (bright) и «оба» (both) с помощью
которых вы можете настроить функцию. Что бы
передвинуть один из ползунков, наведите мышь
на соответствующий ползунок, нажмите и
держите правую кнопку мыши,  и двигайте ею в
правую или левую стороны. После того как вы
передвинули ползунок в желаемое положение,
отпустите кнопку. Ползунок «тёмный»
определяет нижний предел изменения. Ползунок
«светлый», соответственно, верхний предел
изменения. При помощи ползунка «оба», вы
можете двигать два ползунка одновременно, без
изменения интервала между ними.

Во время движения одного из ползунков,
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вы можете наблюдать эффекты на изображении незамедлительно.
Ниже трёх ползунков, вы можете видеть строку с тремя числовыми полями. Левое и

правое поле отображают значения верхнего и нижнего пределов. Поле посередине,
показывает интервал между этими двумя  значениями. В примере на Рисунке 14, нижний
предел равен 322, а верхний – 751. Это означает, что все пиксели с пиксельным значение
меньше 322 будут отображаться в чёрном цвете, а все пиксели с пиксельным значением
больше 751 будут показаны белыми.

Теперь вы можете распознать по гистограмме, что яркость возрастает линейно от
тёмного к светлому в пределах лимитирующих значений. Поэтому, части объектов с
пиксельными значениями в пределах лимитирующих значений отображаются с высоким
контрастом.

Во время движения ползунка «тёмный» и, тем самым, изменяя значение нижнего
предела, часть изображения выделена красным. Красные участки на изображении помечают
все пиксели, чьи пиксельные значения попадают в текущий диапазон. Поэтому, становится
легче определить, какие пиксели лежат выше предельного значения. Таким же образом, все
пиксели с пиксельными значениями, относящимися к  верхней части предельных значений,
отображаются красным во время движения ползунка «светлый».

Усиление контраста
Линейное изменение уровня серого предлагает ещё одну опцию: кнопку «усиление

контраста» (contrast enhancement). Если эта опция включена, программа попытается
адаптировать направление кривой яркости к текущим значениям пределов для объекта.
Районы пиксельных значений, содержащие много пикселей, отображаются во время процесса
с большей контрастностью, чем районы, где содержится всего несколько пикселей.

Примечание: Если вы хотите использовать опцию «Усиление контраста», то

сначала, вы должны переместить ползунок «светлый» так далеко влево, что бы

фоновый пик лежал правее ползунка «светлый».
Криволинейное  изменение уровня серого

В отличие от линейного изменения
уровня серого, кривая яркости при
криволинейном изменении уровня серого не
является линейной по отношению к
пиксельным значениям: с помощью
контрольных точек, вы можете установить
практически любое направление кривой
яркости, какое пожелаете.

Рисунок 15 показывает окно, после
выбора закладки «Криволинейное изменение
уровня серого»

На гистограмме находятся 6
контрольных точек ^1, с помощью которых вы
можете настроить уровень яркости кривой. Что
бы передвинуть одну из контрольных точек,
наведите мышь на контрольную точку,
нажмите и, удерживая левую кнопку мыши,
двигайте точку. После того как вы передвинули
точку в желаемое положение, отпустите кнопку.

Во время перемещения контрольной точки, форма белой линии на гистограмме будет
меняться, и вы сможете наблюдать эффект прямо на изображении.
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Как описывалось ранее, белая линия показывает с какой яркостью отображаются
отдельно взятые пиксельные значения. Чем круче поднимается кривая в районе пиксельного
значения, тем больше контраста будет создаваться между пикселями в этом районе.

Пожалуйста, посмотрите на пример на Рисунке 15: С помощью высокого кластера в
левой части гистограммы, вы можете видеть, что большое количество объектных пикселей
имеют маленькое пиксельное значение. Итак, этот район пиксельных значений представляет
большой интерес. Контрольные точки гистограммы расположены так, что белая линия в левой
части, где расположена большая часть пикселей, поднимается круто, а затем выравнивается в
правой части. Интересная часть объекта, тем самым, отображается с высоким контрастом.

Кубическая и линейная интерполяция
Рисунок 16 показывает разницу между двумя видами интерполяции: расположение

контрольных точек одинаково для обеих гистограмм, различается лишь вид интерполяции. При
кубической интерполяции, линия яркости проходит всегда ровно, другими словами, не имеет
пиков. При линейной интерполяции, одиночные контрольные точки соединяются прямыми
линиями, так что на контрольных точках образуются пики.

Кубическая интерполяция особенна, подходит для настройки плавных кривых яркости.
Для кривых с острыми краями, больше подходит линейная интерполяция.

       Кубическая интерполяция Линейная интерполяция
Рисунок 16

Применение линейного изменения
Как уже говорилось во вводной части этой главы, интересующие части объекта часто

ограничены малой площадью пиксельных значений. При криволинейном  изменении уровня
серого, возможно увеличить гистограмму нажав кнопку «применить линейное изменение»
(apply linear variation) (см. Рисунок 17). Если «применить линейное изменение» активировано,
будет отображаться только та часть гистограммы, которая находится между ползунками
«тёмный» и «светлый» линейного изменения уровня серого. Это позволяет более точно
настроить кривую яркости.
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Изменение уровня серого, шаг за шагом
В этой главе рассматривается настройка изменения уровня серого шаг за шагом на

примере одного рентгеновского снимка.

Шаг 1: Снимок без изменения уровня
серого

На Рисунке 18 показан рентгеновский снимок и гистограмма археологической находки
сразу после сканирования. Без изменения уровня серого, виден только чёрный объект на
переднем плане и фон белого цвета.
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Шаг 2: Первое исследование

Во первых вы должны определить, без помощи линейного изменения, в какой области
оттенков серого находятся интересующие детали объекта. Для этих целей, ползунки «тёмный»
и «светлый» на Рисунке 19 установлены на очень маленький диапазон значений пикселей.
Сейчас детали внутри объекта стали чётко видны. Тем не менее,  грани объекта больше не
видны.

Шаг 3: Регулировка
линейного изменения
уровня серого в
объекте

Детали внутри
объекта хорошо видны на
Рисунке 19.  Но было бы
предпочтительнее, если
бы в то же время грани и
контуры объекта
оставались различимыми.
Что бы добиться этого,
ползунки «тёмный» и
«светлый» разводятся так
далеко друг от друга, что
бы все значения пикселей
объекта лежали между
ползунками.

Для более точных настроек ползунков, программа предлагает помощь: Сначала,
передвиньте ползунок «светлый» в самый правый конец, а затем медленно вновь в левый
конец. Как описывалось в Главе 0, части изображения подкрашиваются красным во время
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процесса. До тех пор пока ползунок находится у правой стороны, только фоновые части
подкрашиваются красным. Когда ползунок достигает середины гистограммы, фон снова станет
белым, а грани объекта подкрасятся. Если ползунок двигается влево, красные области
сместятся по направлению к середине объекта. Ползунок «светлый» должен быть установлен
так, что бы пиксели внешнего края объекта были подкрашены в красный.

Ползунок «тёмный» настраивается похожим образом: он должен медленно двигаться
слева направо, до тех пор, пока первые пиксели в центре объекта не начнут становиться
красными

Шаг 4: Переключение к сплайновому изменению уровня серого

После установи линейного изменения уровня серого, исходя из шага 3, оно будет
изменено на криволинейное изменение уровня серого. Для того что бы увеличить гистограмму,
должна быть активирована опция «применить линейное изменение» (apply linear variation).

Шаг 5: Настройка сплайнового изменения уровня серого для объекта
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В шаге 1 было замечено, что детали внутри объекта в основном лежат в более низкой
зоне уровней серого. Поэтому имеет смысл показать пиксели из низких уровней серого в
относительно большем контрасте. Не интересующая нас грань объекта в более высокой зоне
уровней серого должна оставаться заметной, но можете отображаться с меньшим контрастом.

Желаемое изображение достигается путём криволинейного  изменения уровня серого
на Рисунке 22: Кривая яркости круто поднимается в нижней зоне уровней серого, так что бы
детали в центре объекта были показаны с большей относительной контрастностью. Кривая
яркости выпрямляется больше и больше в верхней зоне уровней серого, так что бы грани
объекта оставались видимыми, но показывались с меньшей контрастностью.

Дополнительные функции изменения уровня серого
Сохранение и загрузка изменения уровня серого

При помощи кнопки «Сохранить» (Save), вы можете сохранить существующее
изменение уровня серого. После нажатия на «Сохранить», вы можете ввести в окне имя
файла, под которым изменение уровня серого должно быть сохранено.

При помощи кнопки «Загрузить» (Load), вы можете загрузить сохранённое изменение
уровня серого из файла.

Если вы сканируете одни и те же объекты с такими же настройками снова и снова,
может быть полезно, выставить оптимальные настройки изменения уровня серого и сохранить
их. После вы сможете использовать сохранённые изменения уровня серого для всех других
снимков.

Сохранённые изменения уровня серого также могут быть использованы для
оптимизации отображения рентгеновских снимков в процессе прокрутки (см. Глава 5).

Новый снимок с изменением уровня серого
Если вы поменяли изменение уровня серого, только изображение снимка будет

изменено. При этом данные снимка останутся без изменений. Таким образом, гарантируется
сохранность оригинального снимка (и всей хранящейся в нем информации) во время
изменения уровня серого.

Однако, в некоторых случаях, бывает желательно изменить не только изображение
снимка, но и все данные. Например, если у объекта слишком маленькая контрастность, может
быть сложно, установить линейное отклонение правильно.

Для этой цели вы можете найти кнопку «Новое изображение» (New image) в окне
изменения уровня серого. Если вы нажмёте на эту кнопку, программа создаст новое снимок,
используя текущее изменение уровня серого.
Снимок создаётся в новом окне, так, что бы оригинальный снимок не был утерян.

Обработка изображений
Обрезка краёв

Отсканированные изображения могут быть очень большими. Если вас интересует лишь
небольшая часть изображения, вы можете использовать функцию для обрезки краёв
фотографии. Для этого выберите функцию «Редактировать =>  Обрезать края» (Edit => Cut
edges) из меню или кликните на иконку j в панели инструментов. Далее необходимо выбрать
нужную область. Для этого кликните левой кнопкой мыши на первый угол этой части
изображения. Не имеет значения, какой угол вы выберите первым – левый, правый, нижний
или верхний. Затем отпустите кнопку мыши и передвиньте мышь. Во время движения вы
увидите прямоугольник, тянущийся от первого угла к фактическому положению мыши. Если
изображение больше чем экран, произойдёт автоматическая прокрутка, как только вы
достигните края экрана.

Если вы нажмёте второй раз что бы зафиксировать прямоугольник, следующее
предупреждение появится на экране «Обрезание краёв невозможно отменить. Вы хотите
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продолжить?» (Cut edges cannot be undone. Do you want to proceed?). Если вы нажмёте «Да»,
края за пределами прямоугольника будут удалены.

Вы можете отменить выполнение этой операции в любой момент, нажав ESC.

Предупреждение: После того как вы обрезали, их невозможно будет вернуть. Теперь

вы можете работать с выбранной областью изображения, используя функции меню.

Инвертирование снимков
Рентгеновская камера делает, так называемые, позитивные снимки, в отличие от

обычных плёночных рентгеновских систем. Это означает, что сильно облучённые части
снимков получаются светлыми, а менее облучённые – темными. Обычные рентгеновские
системы действуют обратно: сильно облучённые части снимков получаются темными,
подверженные меньшему облучению – светлыми.

Вращение изображений
Функция вращения даёт возможность повернуть изображение на 90° в левую или

правую стороны.

Зеркальное отображение снимков:  горизонтально и вертикально
Функции отражения дают возможность отразить изображение горизонтально (слева-

направо) или вертикально (сверху-вниз)

Рельефные изображения
Эта функция позволяет создать рельеф для рентгеновского снимка (см Рисунок 23).

Части изображения с однородной яркостью на рельефе выглядят как гладкая поверхность.
Переходы от светлого к тёмному представлены в виде участков подъёма, а переходы от
тёмного к светлому – в виде углублений. Таким образом, создаётся впечатление трёхмерной
изображения.

     Оригинальное изображение  Рельеф

Рисунок 23

После того как вы выбрали рельефную функцию, вы можете изменить ее настройки в
окне. Параметр «Направление света» (Direction of light) определяет с какой стороны рельеф
подсвечивается. Рельефное изображение на Рисунке 23 подсвечивается сверху, слева.
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Параметром «Глубина» вы можете назначить (Depth) расстояние между высоко- и низко
посаженными частями рельефа.

Рельеф создаётся в новом окне. Таким образом, оригинальный рентгеновский снимок не
теряется. Эффект рельефа достигает лучших результатов на изображениях со средним или
высоким контрастом.

Медианный фильтр
На каждый рентгеновский снимок накладывается, так называемый, квантовый шум.

Квантовый шум негативно влияет на качество снимка.
Квантовый шум на рентгеновском снимке может быть уменьшен при помощи

медианного фильтра, без слишком большого размытия. Изображение остается чётким,
несмотря на применение медианного фильтра. Тем не менее, очень маленькие детали все же
теряются из-за медианного фильтра.

Доступны две различные силы воздействия медианного фильтра. После того как вы
вызвали медианную функцию, вы можете выбрать силу в окне: Фильтр «5х5» удаляет больше
квантового шума, чем фильтр «3х3». Но при применении фильтра «5х5» больше деталей
снимка будут утеряны, чем при применении «3х3» фильтра.

Биннинг
С помощью этой функции, несколько пикселей на рентгеновском снимке соединяются в

один путём усреднения. Таким образом, квантовый шум на снимке уменьшается. Биннинг
помогает улучшить соотношение сигнала к шуму. Но, как результат, разрешение снимка
падает.

После вызова функции биннинга, вы должны ввести в окно, сколько пикселей будет
соединено по оси X (горизонтально) и сколько по оси Y (вертикально). Новое изображение
будет создано в новом окне, поэтому оригинальный снимок не пострадает.

Примечание: Что бы ни искажать геометрические пропорции рентгеновского

снимка, важно указать одинаковое количество пикселей по обоим осям.

Измерение снимка
Программа предоставляет различные средства для выполнения измерений снимка

Выбор единиц измерения для координат и расстояний
Для отображения координат и расстояний, доступны три различные единицы измерения:

Пиксель, миллиметр и дюйм. Вы можете выбрать в меню «Измерения» (Measurements)
единицы измерения которые будут использованы.

Значения координат и пикселей снимка
Отображение в строке состояния
Во время перемещения мыши внутри

изображения, текущие координаты пикселя, над
которым находится указатель мыши, и его
значение отображаются в строке состояния.
Примечание: Если включено изменение уровня серого, реальное значение пикселя не

будет отображаться; вместо этого будет показано результирующее, после

изменения уровня серого, значение.
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Отображение в окне «Информация о пикселе»
При помощи функции «Смотреть => Информация о

пикселе» (View => Pixel information) вы можете вывести или
спрятать окно «Информация о пикселе».

Это окно показывает, в виде матрицы, значения пикселей,
которые окружают указатель мыши (Рисунок 25). Значение
пикселя, над которым находится курсор, показано голубым
цветом в середине матрицы. Значения непосредственно
прилегающих пикселей отображается красным цветом, а
значения находящихся рядом – зеленым.

Вы можете читать с самого нижней строчки экрана, на
которой находится указатель мыши.

Примечание: Если включено изменение уровня серого,

реальное значение пикселя не будет отображаться;

вместо этого будет показано результирующее, после изменения уровня серого,

значение.

Измерение расстояний
Для того что бы измерить расстояния,

наведите курсор мыши на начальную точку, с
которой хотите начать отсчёт. Затем нажмите и
держите левую кнопку мыши. Это точка теперь
служит точкой отсчёта, а указатель мыши сменился на крестик. Если вы теперь двинете
мышью, не отпуская при этом кнопку, появится мерник из точки отсчёта до данной точки. Длина
этого мерника отобразится в строке состояния.

Как только вы отпустите левую кнопку мыши, мерник исчезнет, и вместо расстояния, в
строке состояния, вновь появятся координаты.

Измерение градиентов уровня серого с помощью профиля пикселя
Градиент уровня серого в строке может быть измерен при помощи профиля пикселя.

Профиль пикселя вызывается через измерение расстояния:
Сперва передвиньте указатель мыши на пиксель, с которого должен начинаться

профиль пикселя. Затем нажмите и держите левую кнопку мыши, передвигая указать в точку,
где профиль пикселя должен закончиться. Во время этого процесса, на экране появится
изображение мерника.

Продолжайте держать левую кнопку мыши и, в дополнение, нажмите правую кнопку
мыши. Таким образом, откроется новое окно, в котором отображается градиент значений
пикселей вместе с диаграммой. (см. Рисунок 27). Теперь можете отпустить обе кнопки мыши.
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Рисунок 27

Ось X диаграммы представляет расположение на мернике. Там всегда используется
единица измерения «Пиксель». Слева показан пиксель, с которого начался ваш отсчёт
расстояния, по нему вы кликнули левой кнопкой мыши. Справа пиксель, при наведении на
который вы нажали на правую кнопку мыши. На оси Y отображаются соответствующие
значения пикселей. Если изменение уровня серого включено, реальные значения пикселей
показаны не будут, вместо них будет показано результирующее, после изменения уровня
серого, значение.

Если вы будете двигать курсором внутри диаграммы, ближайший пиксель будет
помечен красным крестиком на диаграмме. Значение этого пикселя, равно как и его расстояние
от начальной точки измерения, будет отображаться под диаграммой. Кроме того,
расположение пикселя будет помечено на мернике, на  изображении.

Изображение диаграммы может быть изменено при помощи двух кнопок внизу слева в
окне профиля. Если кнопка E3| активирована, профиль пикселя будет представлен в виде
соединённой линии. Если активирована кнопка Ц], каждый пиксель будет представлен в виде
вертикальной черты.

Нажмите «ОК» что бы закрыть окно профиля пикселя.

Сохранение и загрузка снимков
Сохранение снимков

Для того что бы сохранить отсканированный рентгеновский снимок, выберите «Файл =>
Сохранить» (File => Save) из меню или нажмите на иконку H | на панели инструментов. В
появившемся окне, вы можете задать имя файла и место, в котором снимок будет сохранен.

Программа использует собственный формат «PIX» для сохранения рентгеновских
снимков. Этот файл содержит не только изображение, но и дополнительную информацию
(такую как изменение уровня серого).

После того как вы сохранили рентгеновский снимок, имя файла появится в заголовке
окна, в котором отображается снимок. Если вы внесёте изменения в снимок (например,



50

установите другое изменение уровня серого), вы можете сохранить изменения нажав «Файл =>
Сохранить», не вводя имя снова. Если вы хотите сохранить снимок под другим именем,
выберите «Файл => Сохранить как» (File => Save as).

Загрузка снимков
Для того что бы загрузить ранее сохранённый рентгеновский снимок, выберите «Файл

=> Загрузить» (File => Load) из меню или нажмите на иконку J^J в панели инструментов. В
появившемся окне, вы сможете выбрать какой снимок загрузить.

Альтернативой является загрузка рентгеновского снимка прямо из Windows Explorer, не
запуская предварительно программу iX-Pect. Для этого вам нужно два раза кликнуть левой
кнопкой мыши по иконке с нужным снимком. Программа запустится автоматически, и
изображение будет загружено.

Экспорт изображений
Если вы хотите использовать рентгеновский снимок в других редакторах изображений

или в документе, вы должны экспортировать изображение. Для этого выберите «Файл =>
Сохранить как» (File => Save as) из меню. В появившемся окне, в поле «Тип файла» (File type)
вы можете указать формат файла, в котором должно быть сохранено изображение.

Важно: Программа умеет распознавать изображения только в формате

«PIX». Поэтому, если вы выберите другой формат, вы не сможете загрузить

это изображение в iX-Pect.
Если вы экспортируете снимок в другой формат файла, будет использовано текущее

изменение уровня серого, а не оригинальное. Следующие форматы доступны для экспорта:

BMP - Windows bitmap

BMP стандартный формат изображений “Windows Bitmap”, который

используется во многих программах.

Формат BMP может сохранять уровни серого глубиной до 8 бит. Это значит, что
изображение в BMP не может сохранить активный диапазон камеры в 12 бит. Поэтому, прежде
чем экспортировать в BMP, вы должны установить изменение уровня серого таким образом,
что бы все важные детали были видны при 8 битах (256) изменений.

TIF - Tagged image file format

Если вы выбираете тип файла «TIF», вы можете сохранить изображение в

8 или 16 битах.

· 8 Bit TIF: Как и формат BMP, 8 битный TIF является стандартных форматом, который
поддерживается множеством программ. Также, в этом формате может произойти потеря
информации об уровнях серого. Поэтому, прежде чем экспортировать снимки в формат
TIF,  вы должны установить изменение уровня серого таким образом, что бы все важные
детали были видны при 8 битах (256) изменений.

· 16 Bit TIF: 16 битный TIF формат это особая форма TIF формата. В отличие от BMP и 8
Bit TIF, в этом формате можно сохранять рентгеновские снимки без потери качества. 16
Bit TIF поддерживается меньшим числом программ, чем 8 Bit TIF.
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FLD - Binary field
Формат FLD сохраняет изображения в виде необработанного бинарного файла без

заголовка. Если вы экспортируете рентгеновский снимок как  FLD файл, программа создаёт два
файла. Первый, с расширением «.FLD», содержит описание изображения в виде ASCII-кода.
Второй файл, с расширением «.BIN» содержит реальную информацию по изображению. Если
вы, например, введете имя файла «image1», программа создаст два файла:  «image1.fld» и
«image1.bin». Формат FLD файла, описывающего изображение, можно проиллюстрировать
следующим примером: Снимок размером 1632 пикселя в  ширину и 696 пикселей в высоту.
Файлу было присвоено имя «My image». В таком случае, созданный файл FLD выглядит
следующим образом:

Записи в FLD-файле Описание
# AVS field file Идентификационный код заголовка (фиксировано)
ndim = 2 Изображение двухмерное (фиксировано)
dim1 = 1632 Ширина изображения = 1632 пикселей
dim2 = 696 Высота изображения = 696 пикселей
nspace = 1 (фиксировано)
veclen = 1 (фиксировано)
data = short Тип пиксельных данных: короткий (1 Пиксель = 16 Бит)
field = uniform (фиксировано)

variable 1 file=My image.bin

filetype=binary skip=0 endian=ibm

1. вспомогательный файл с данными изображения

2. тип файла бинарный

3. (фиксировано)

4. прямой порядок байтов (низкий байт / высоки байт)

Пиксельные данные в файле «My image.bin» строятся следующим образом:

Смещение Описание
0000 0000 Низкий байт Пиксель (x=0,y=0)
0000 0001 Высокий байт Пиксель (0,0)
0000 0002 Низкий байт Пиксель (1,0)
0000 0003 Высокий байт Пиксель (1,0)
.... ....
0000 0CBE Низкий байт Пиксель (1631, 0)
0000 0CBF Высокий байт Пиксель (1631,0)
0000 0CC0 Низкий байт Пиксель (0,1)
0000 0CC1 Высокий байт Пиксель (1,1)
.... ....
0022 AA00 Низкий байт Пиксель (1631,
0022 AA01 Высокий байт Пиксель (1631,

6.0 Отключение Системы GW-4
Закройте приложения Кроулера и программу iX-Pect.
Выключите компьютер.
Отсоедините источники энергии и системные кабели.
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7.0  Обслуживание

7.1 Общее
Компьютер – Периодическая дефрагментация жёсткого диска, сканирование на наличие

вирусов, удаление временных файлов рекомендовано каждый месяц или при необходимости
поддержать хорошую производительность. Избегайте установки посторонних приложений на
компьютер GW-4, они могут сказаться на работе iX-Pect.

Отрегулируйте натяжение ремня, что бы добиться отклонения в 1/8’’, в середине
длинной верхней части ремня, при силе воздействия около 1.5 фунта. Подтяните ремень, если
он сползает на рабочий шкив.
Тележки – Периодически производите осмотр ремённого привода и направляющих роликов на
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8.0 Характеристики
Система GW-4 ™  предназначена для труб, с минимальным внешним диаметром 12”

· SA-3-320HE CMOS SegmentedArray™ регистратор 3” активная линейная область CMOS
20KV-320KV   рабочий диапазон 80 micron пространственное разрешение, 12 bit
динамичный диапазон

· Переносная рабочая станция Portable PC Workstation с колесным корпусом, 24” TFT
SXGA дисплей с 400 NITS яркостью и 1000:1 контрастом, PCI интерфейс и MUX карты,
Crawler интерфейс контроля и отображения

· Интегрированный пакет программного обеспечения
· Windows XP professional. Пакет программного обеспечения iX-Pect для сбора/обработки

рентгеновских снимков. Функции обработки включают в себя: оптимизацию контраста,
увеличение, инвертирование, тиснение, гистограмму, медианный фильтр, биннинг,
усиление граней и псевдо-цвет. Прокрутка в реальном времени и мониторинг излучения.
Снимки могут быть экспортированы в  .tif,  .bmp,  .fld  или .pix.  Снимки сохраняются на
жестком диске, CD-R/RW и DVD-R.  Программа Visual Basic для управления тележкой, с
удобным окном управления, включающим включение/выключение, контроль скорости.
Скорость сканирования тележки управляется через программу iX-Pect.

·  120’ кабелей связи для движения тележек и сканирования

По вопросам технической помощи, пожалуйста, обращайтесь:
Envision CmosXray LLC

7800 King Street

Anchorage, AK 99515

907-563-1141

907-563-1142 fax

info@cmosxray.com

mailto:info@cmosxray.com

